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Experiment 2: Errors

. Sources of Errors in Physical Measurements

hysics is often referred to as an "exact science." Actually it is exact only in degree. For example,
the accepted value of the velocity of light is (2.997923 + .000008) x 1010 cm/sec. The figure

2.997923 x 1010 cm/sec represents the best estimate of velocity, while that of .000008 x 1010 cm/sec is
an indication of the reliability of the result.

Most experiments in physics give as their immediate result some numerical quantity which will be
uncertain by some amount. For some measurements the uncertainty may be large while for others it
may be small. It is important to be able to estimate the uncertainty in a measurement so that one is able
to decide whether differences between one experiment and another or between experimental results and
theoretical results are significant.

If an experiment is repeated many times, in general the results will not be precisely the same. Since the
basic assumption of physical science is the consistent behavior of natural phenomena (with the
exception of quantum effects which are noticeable only on the extreme microscopic level) this variation
is considered to arise from not exactly holding the experimental conditions the same between
measurements, and we say that there is some amount of experimental error in the measurement.

Experimental errors which contribute to the uncertainty of physical measurements can be divided into
two kinds.

. Systematic Errors

These are errors which are systematically introduced into measurements and stem from controllable
factors associated with the measurement process. These kinds of errors produce a reproducible
inaccuracy such as a measurement which is consistently too large or too small.

Some examples of systematic errors are: In measuring the time for a ball to roll down an inclined
plane, the observer may introduce a systematic error due to the reaction time required for him to stop
the timer after he sees the ball at the bottom. In measuring a length with a steel tape or calipers, whose
temperature is above or below the calibration temperature, one will obtain values which will be
systematically either too large or too small. A wooden meter stick which has shrunk after the scale was
stamped on it will give too large a value consistently. An observer may introduce an error by
consistently holding his or her head too far to one side when reading a needle and scale having parallax.
Failure to correct for temperature and pressure will introduce systematic errors into some
measurements.

Notice that the examples discussed above can be further subdivided into two types. These are:

A. Instrument Errors

Instruments used to measure various physical quantities may have inherent or built-in errors.
Most of the equipment in the laboratory is sufficiently accurate so that either instrumental errors
are negligible or appropriate corrections can be made for the experiments that you will be doing.
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Some instruments, such as voltmeters and ammeters, have a limited accuracy built in, and the
manufacturer will usually specify the limit of accuracy. In some cases instruments and
apparatus can be calibrated to be more accurate.

B. Human Errors

Sometimes an observer will unconsciously introduce errors by the failure to take proper care in
making or interpreting measurements. For example, the observer may not be aware that a
condition that should be held constant during the experiment (for example the temperature) may
be changing in a systematic manner (for example slowly increasing). In addition, as noted
above the observer may consistently misread an instrument. Another important type of
systematic human error is one introduced by personal bias, such as trying to fit the
measurements to some preconceived idea or being prejudiced in favor of the first observation.

In principle, systematic errors can be eliminated or minimized by the control of the proper factors
involved in taking the measurements.

Ill. Random Errors

After all known sources of error have been removed, repeated measurements of the same quantity might
still fail to agree exactly; when observations are repeated, they fluctuate slightly about a mean value.
Random errors originate from several sources. Fluctuating conditions such as changes in temperature,
pressure or line voltage can introduce random errors. Small disturbances such as mechanical vibrations
or spurious signals from nearby machinery can introduce errors. They are nearly impossible to detect.
Even if the measuring process was perfect, repeated measurements might fail to agree because the
quantity being measured might not be precisely defined. For example, the "length" of a rectangular
table is not an exact quantity for a variety of reasons, the edges are not entirely smooth, the sides are not
pertectly parallel, nor is the surface exactly flat. Thus even with a perfectly accurate measuring device
the value is found to vary depending upon where the "length" is measured.

Human error can also be of a random nature. For example, to obtain the proper reading on certain
kinds of instruments (calipers, meter sticks, micrometers, and others) an estimate of the final
meaningful digit must be made between the smallest divisions on their scales. Particular care must be
taken to ensure that these types of estimates are made as precisely as possible. If these estimates are
made carelessly it is likely to be done in a random manner. Other human errors occur due to outright
blunders such as mistakes in reading instruments or failure to record correctly the actual reading of the
instrument directly on the data sheet.

IV. Accuracy of Physical Measurements

A. Uncertainties
Every measurement of a physical quantity is uncertain by some amount. For our purposes it is

convenient to consider three types of uncertainties which are useful in evaluating the accuracy of any
measurement.
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The absolute uncertainty in a measurement is defined as the smallest division which may be read
directly on the instrument used to take the measurement. For an ordinary meter stick the absolute
uncertainty would therefore be 0.1 cm or 1 mm. The relative uncertainty is obtained by dividing the
absolute uncertainty by the actual value of the measurement expressed in the same units. The percent
uncertainty is 100 times the relative uncertainty. If a one meter stick is used to measure distances
exceeding 1 meter, then the absolute uncertainty would be N times 1 mm where N is the successive
number of times the meter stick must have been positioned to measure the total distance.

In most cases the relative uncertainty is more important than the absolute uncertainty. If we measure
the length of a rod with a meter stick and find it to be 231 mm, we usually regard an uncertainty of 1
mm less important than if we measure the diameter of the rod to be 5 mm with an uncertainty of 1 mm.
In the first case the uncertainty is 0.4%; in the second case it is 20%.

B. Significant Figures

In recording data and results it is customary to keep only figures that are trustworthy and have some
significance. They are called significant figures and are always determined by the amount of error in
the value they express. As an example, consider a distance measured to the nearest hundredth of a
centimeter and found to be 50.00 cm. This reading should not be recorded as 50 cm because this
implies that the distance has been measured only roughly and has been found to be more nearly equal
to 50 cm than to 49 or 51 cm. Recording the observation as 50.00 cm indicates that the distance lies
between 49.99 and 50.01 cm. Itis uncertain by +0.01 cm or £0.02%. Writing the distance as 50.00
cm implies that the fourth figure, counting from the left, is the last figure in which any confidence can
be placed.

The number of significant figures is independent of the position of the decimal point. Both 50.0 cm
and 0.00500 cm have three significant figures and each is assumed to be known to within +0.2%. The
best way of representing the number of significant figures of a quantity is to show only the significant
figures, placing the decimal after the first significant figure and multiplying by the appropriate positive
or negative power of ten. For example, if the mass of an object is about 253341 gm and three figures
are significant, that is, the third figure is the last in which any confidence can be placed, the mass should

be written as 2.53 x 105 gm. Notice that the mass was measured as 253341 gm but because of the

error or lack of confidence in the 4th and 5th figures it was "rounded off" to be 2.53 x 105 gm. In
casting off non significant figures, if the value of the rejected figures is greater than one-half unit in the
last place retained, increase the last digit retained by 1; if it is less than half, leave the digit unchanged; if
it is exactly one-half increase the last digit only if it is odd.

C. Combinations of Measurements

Many quantities are determined by combining several measurements. For instance, speed is found by
dividing a measured distance by a measured time. To find how many figures should be kept in the
result and how accurately the several quantities involved should be measured, the following rules should
be observed.

Sums and differences: Quantities to be added or subtracted should be written to the same decimal
place, irrespective of whether or not they have the same number of significant figures. No more
decimal places should be retained in the result of the sum or difference than can be trusted in the
quantity having the fewest trustworthy decimal places.
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Products and quotients: Quantities which are to be multiplied or divided should be written to the same
number of significant figures. It is common practice to carry only one doubtful or "non-significant"
figure in all calculations until the final result; one cannot increase the reliability of the results simply by
carrying out long-division to many decimal places. No more significant figures should be retained in
the result of the product or quotient than exists in the factor with the fewest trustworthy figures.

D. Summary of Rules for Significant Figures®

Rule 1 : Counting from the left and ignoring leading zeros, keep all digits up to the first doubtful one.
That is, x = 3 m has only one significant figure, and expressing this value as x = 0.003 km does not
change the number of significant figures. If we instead wrote x = 3.0 m (or equivalently, x = 0.0030
km), we would imply that we know the value of x to two significant figures. In particular, don't write
down all 9 or 10 digits of your calculator display if they are not justified by the precision of the input
data! Most calculations in this text are done with two or three significant figures.

Be careful about ambiguous notations: x = 300 m does not indicate whether there are one, two, or three
significant figures; we don't know whether the zeros are carrying information or merely serving as place

holders. Instead, we should write x = 3 X 102 or 3.0 X 102 or 3.00 X 102 to specify the precision more
clearly.

Rule 2 : When multiplying or dividing, keep a number of significant figures in the product or quotient
no greater than the number of significant figures in the least precise of the factors. Thus

23X3.14159=17.2
A bit of good judgment is occasionally necessary when applying this rule:
9.8 X 1.03=10.1

because, even though 9.8 technically has only two significant figures, it is very close to being a number
with three significant figures. The product should therefore be expressed with three significant figures.

Rule 3 : In adding or subtracting, the least significant digit of the sum or difference occupies the same
relative position as the least significant digit of the quantities being added or subtracted. In this case the
number of significant figures is not important; it is the position that matters. For example, suppose we
wish to find the total mass of three objects as follows:

1039 kg
210 kg
0319 kg

106.319 or 106.3 kg

The least significant or first doubtful digit is shown in boldface. By rule 1, we should include only
one doubtful digit; thus the result should be expressed as 106.3 kg, for if the "3" is doubtful, then the
following "19" gives no information and is useless.

*R. Resnick, D. Halliday, K. Krane, Physics, 4th Ed., Vol. 1, John wiley & Sons,
12



Errors 13

V. Theory of Probable Error

An examination of the spread in individual measurements of the same quantity yields information
regarding the probable error contained in the family of measurements. When a large number of
independent measurements or readings is taken of the same quantity in which there are random
differences in the readings, one is usually justified in assuming that the average or mean value is the
most probable value of the measured quantity.

Suppose for example, that we have N measurements of a particular length. The individual values are x;,
X2 ....xy. The mean is given by:

N
2

X =+ Eqn. 1
N q

The average value of the squares of the differences between the measured values and the mean value
(the residuals) is given by

| &

2 =2

u =N2(xi—x) Eqgn. 2
=1

The standard deviation of the set is given by the square root of the above

[ & =
MTN;(xi—x)

About 68% of the individual measurements can be expected to fall within + u of the "true" mean value
(the result you would get for the mean if you could take an extremely large set of measurements;
N — ). When N is finite the best estimate as to the value of standard deviation is given by

I ™
0={(N—l)z(x"_x)

k
Eqn. 3

=

1

Eqn. 4

Notice that o pvaesand U}

A more important quantity, though, is the uncertainty in the value of the mean itself in comparison with
the "true" mean of the parent distribution. This quantity, the standard deviation of the mean itself, o, is
related to o by:

o -2 Eqgn. 5

for our finite set of N measurements assuming that they are normally distributed. There is about 68%

probability that our mean deviates from the true mean for the parent distribution by no more than + o,.
Thus, at the 68% confidence level, we would state our result as:

X*xo, Eqn. 6
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The smaller the value of oy,, the more precise is the determination of X .

As an example, we might have the following set of ten separate length measurements of the same object:

x1 =2.002, xp =2.008, x3=1.991, x4 =1.999, x5 =2.013,

x¢ = 1.987, x7 =2.020, xg =1.990, x9 = 1.991, x;09=1.999 all in meters.

The values for the mean and standard deviation of the mean are X = 2.000 m and o, = 0.003 m, so we
would quote our result as

X =(2.000 = 0.003)m.

A second set of numbers as follows:

X1 =2421, xp =2.79, x3=2.112, x4 =1.788, x5=1.893,
xg =2.207,x7 = 1.844, xg =1.656, x9 =2.232, X109 = 1.768 all in meters

has a mean X = 2.000 m and standard deviation of the mean o, = 0.082 m, so this time we would

quote our result as
X =(2.000 £ 0.082)m

It is clear from the numbers involved that the first set is the more precise set of measurements.

The standard deviation (o) is a measure of the dispersion of the data set and the standard deviation of
the mean (0y,) is a measure of the confidence that we have in the calculated mean value of the data set.

VI. Procedure

Part A.

You will determine the mean range of a spring gun which will be fired 10 times by the instructor onto a
sheet backed by carbon paper. You will also determine the standard deviation of the mean. Record the

horizontal distance to the point of impact to the nearest millimeter each time. Record in the table
below:

1. Range Measurements

X1 = X2 = X3 = X4 = X5 =

X6 = X7 = Xg = X9 = X10=
2. Now use the spreadsheet program to enter this data into the computer. Label the first column

heading with "distance" and add "(meters)" just below it. The 10 range values are typed in
directly below. See Figure 1.
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3. Just below the 10th value create a dashed (---) line across 3 columns (The easiest way to do this is
to type a single (“-”’) dash in cell A13 and then press the enter key. Next select cells A13-C13.
Then do Format->Alignment.... and chose Fill from the dialog box). In cell A14 type
"Average". Then select cell A15, type "=", insert the AVERAGE() function from the FORMULA
paste function menu item, and select A3:A12 as the range to average over. This gives you the
average value of your 10 distances. (Now try changing one of the distances and see the average
change automatically).

4. Head the second column with "Difference" and put "(meters)" below it also. For cell B3, enter
the formula =A3 - $A$15. This gives the difference between the first distance and the average of
all distances.

5. Instead of repeating this formula for the other 9 distances, drag from cell B3 to cell B12. Then
select FILL DOWN from the EDIT menu. The formulas should be entered automatically and
evaluated for you.

6. Head the third column with "Squares" and put "(sq. meters)" below it. Then, in cell C3, form the
square of the difference in cell B3. Repeat your formula in cells C4 to C12 as for column B.
(Remember to use an = sign first).

7. Incell Cl14 type "Standard Deviation". In cell C15 enter an equation for standard deviation; that
is, use the formula menu entry to SUM(C3:C12), divide it by 9, and then take its square root. The
formula bar for cell C15 should read: = SQRT(SUM(C3:C12)/ (10-1))

8. Use the built-in function STDEV() to calculate the standard deviation for cells A3:A12. You can
put this result in cell A17 and its label in A16. Use "=STDEV(A3:A12)".

9. Incell A18 type "Standard Deviation of the Mean". In cell A19 enter an equation for to calculate
the standard deviation of the mean. The formula bar for cell A19 should read:
= A17/SQRT(10) or = A17/SQRT(COUNT(A3:A12)). The latter form has Excel count the
number of data points.

Figure 1 is a display of the formulas that should be in your spreadsheet.
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Figure 1

Figure 2 shows how Excel will display the results calculated by your formulas. Notice in particular the
formatting of the numerical values (i.e. the number of decimal places displayed and the use of scientific

notation (e.g. note cell C4 where 4.41E-06 = 4.41x10-6)).
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10. Now you must format the results to show the proper number of significant
figures!

11. Check with your instructor to see if you have completed part A correctly.

Remember That:

* You must start all formulas with an equal sign
* You should use FILL DOWN to replicate the top formula in a column
+ Keep at least 25K of free space on your disk or you can't save files
* You CAN ONLY save to your own disk
+ Function argument ranges can be selected by clicking and dragging
over the desired cells
Part B.

1. Now you will complete the write-up for Experiment #1 by pasting your Excel results into a Word
document and completing the calculations and analysis section below. Refer to Appendix 2
for the lab report format. Be sure to load both Word and Excel (refer to page A1-10..

2. Remember to use Edit->Copy Picture to make a copy of your Excel sheet. Then switch back to
Word before pasting the sheet into your report. You must hold down the shift key before
selecting the Edit menu.

VII. Calculations and Analysis

1. What are your values for X, o, and o,, ?

2. What is the range (in meters) of x + o ?

What percentage of your individual measurements fell within the rangex + o ?
(On average you would expect 68% of them to do so)

4. What is the range (in meters) of X +o, ?

What is the absolute uncertainty for your measurements?

What is the percent uncertainty (use X for actual value)?

17



Vill. Questions
1. What do you consider to be the major contributing source of errors in the exercise? Why?

2. How might you go about making the distance measurements more precise?
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